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Minimum system requirements 

 

Processor:  1.2Ghz 

Memory:  512 RAM 

Free Disk Space: 4GB 

Microsoft Windows XP Pro with Service Pack 2 
 

 

Software Requirements  

 

Windows Installer 3.1 

Visual C++ runtime library 

SQL Server Express 

.NET Framework 2.0 

 

Please note if you do not have these installed, Bounce Architect setup will install them for 

you. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Introduction 

The bounce software suite is designed to provide a number of software modules and 

tools for defining the integration points between the your data and the EPOP. The 

software enables the development of image templates for simplifying the design of 

ticketing information and provides tools for defining rules that must be applied to the 

data feeds in order to ensure that the correct information is displayed on the EPOPs at 

the right time. The software also provides a network management layer for controlling 

the update of the EPOPs and recording auditing information that can be retrieved 

using the reporting module. 

The software consists of four core elements: 

 

Product Description 

Architect This product consists of a Microsoft .Net application that 

provides the means to define the data sources for product 

information, set up what to do with the data and create a 

schedule of when the data should be examined for changes. 

Architect also provides tools for defining EPOP product image 

templates and for creating Collections of templates that will be 

used with the defined data set. 

The Policies and Collections that are created within Architect 

will then be used by Processor to generate images for the EPOP 

displays. 

Processor This product consists of a Microsoft .Net application that runs 

continuously on a server and uses the Policies and Collections 

defined within Architect to acquire the data when scheduled, 

perform the required transformations, determine what data has 

changed and render product images for those products whose 

data has changed. 

Communicate The product consists of a Microsoft .Net application that runs 

continuously on a server and is responsible for transmitting the 

appropriate product images to any EPOPs that have been 

assigned to the defined products. 

Communicate is responsible for providing the underlying 

communications structure for deploying a large number of 

EPOP display devices. 

Previous releases of Bounce Software consisted of only the 

Bounce Communicate element. 

Manager This product consists of a set of web pages, written for the 

Microsoft ASP.Net web application framework, residing on an 

ASP.Net compatible web server. It provides the tools required 

to manage a Bounce software installation via a Web interface. 

It provides a configuration manager, a report manager and an 

EPOP assignment manager. 



 
Overview Diagram 

 

 

Bounce Architect 

 

Component Description 

Policy Architect The Policy component consists of a Microsoft.Net application 

for defining the sources of data that will be used in acquiring 

the product information for the image generation process. 

Data transformations are also created and edited within Policy 

Architect. Transformations can be used when the format of 

the data in the acquired data sources needs to be changed or 

reformatted to represent what will be rendered in the product 

image. 

Schedules can also be defined within Policy Architect. A 

schedule defines when data should be acquired to determine if 

any changes have occurred in the data set. Any data changes 

result in new images being generated. A schedule can be as 

simple as a trigger based on when a data file changes, or a 

more complex predefined set of times when the data should 

be acquired from a remote database. 

Policy Architect provides a means to preview both the 

acquired data and the EPOP images that will be created from 

the data. 

Any policies that are defined within the Policy Architect 

application can be saved and imported into Bounce Processor 

as a configuration file. 

Template Architect The Template component consists of a Microsoft.Net 

application for defining EPOP image templates. A template 

defines the information that should be displayed on an EPOP. 
It consists of a set of instructions detailing where and how 

data fields are rendered within the EPOP image. 
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Template Architect provides a template Design view alongside 

a Preview view. This allows the User to be able to see exactly 

how a product image (or set of product images) will be 

rendered from the product data set. 

Template Architect also allows the user to create a Collection 

of templates. This feature ensures that different templates 

can be used when rendering the data to handle products that 

may be on offer, or in a different product category that 

requires its own style. A Template Collection also includes 

templates for each of the different EPOP types e.g. EPOP 500 

and EPOP 300. 

Once a User has completed the design of their Template 

Collection it can then be saved and imported into Bounce 

Processor as a configuration file. 

Saved files can also be used by Policy Architect to preview the 

acquired data.  

Processor 

 

Component Description 

Processor 

Acquire/Transform/Render 

This component runs as a Service on any Windows XP 

machine and performs the function of acquiring the data 

against a schedule of operation as defined in Architect. It 

then performs any required transformations and uses 

the acquired and transformed data to render a product 

image. 

For each product in the acquired data set a unique image 

will be generated using the specific template style 

defined within the data. Product images are created for 

each EPOP type included in the Template Collection e.g. 

EPOP 500, EPOP 300. 

Once an image has been rendered it is then passed to 

the Communicate component for transmission to the 

EPOPs. 

An audit trail is kept of when the data is acquired and 

when any product images are created and sent to the 

Communicate component. 

 

Communicate 

 

Component Description 

Processor 

Communicate 

This component also runs as a service on any Windows XP 

machine and is responsible for managing the transmission of 

any product images delivered via Acquire/Transform/Render 

to the appropriate EPOP units assigned to the product. 

When Communicate receives a product image update it will 

check to see if any EPOPs have been assigned to the product 

and then select the appropriate image for the specific EPOP 

type and queue it for transmission e.g. if a product has both 

an EPOP 500 and an EPOP 300 assigned, then Communicate 



 

 

selects the EPOP 500 image for transmission to the EPOP 500 

and the EPOP 300 image for transmission to the EPOP 300. 

Communicate manages the RF communications layer and will 

ensure transmissions are re-tried if failures occur due to RF 

noise etc. 

An audit trail is kept of all EPOP communications, retries and 

failures. 

 

Manager 

 

Component Description 

Configuration 

Manager 

The Configuration component consists of a web application 

that enables Users to remotely configure and control the 
Bounce Processor product. 

Users are able to update the Policy rules and Template 

Collections. 

Assignment Manager The Assignment component consists of a Windows .Net 

application for assigning EPOP units to products defined within 

Bounce. 

This application supports the use of barcode readers to 

simplify the EPOP assignment process. A User can simply scan 

the barcode of a product and the EPOP serial number label 

and then Assignment Manager will send a request to Bounce 

Communicate to set up an assignment between the product 

and the EPOP. This will result in the EPOP being updated with 

the latest product image for the selected product. 

Other variants of this component can be created for Windows 

Mobile PC or other handheld applications. 

Report Manager The Report component provides a web based application that 

enables the User to generate reports detailing when products, 

EPOPs etc. have been updated. 

Reports can also be generated of failed transmissions. 

 



 

Workflow 

The following diagram shows an overview of the workflow required to integrate a 

bounce system into a retail environment.  

 

 

 

There are 7 steps to complete a full integration. These are: 

1. Use Policy Architect to set the data sources and define the Template Fields that 

will be used in creating the product images. Template Fields are derived either 

directly from the Product Data Fields in the imported data sources or from 

transformations on the Product Data Fields. 

2. Use Template Architect to create a Collection of image templates for each EPOP 

type and for each offer type using the Template Fields defined in step 1  
Steps 1 & 2 often become an iterative process as the templates are developed. 

3. Use Policy Architect to define the scheduling policies that determine when the 

data will be acquired from the defined data sources and when the images will 

be transmitted to the EPOP devices. 

4. Acquire the Data Values according to the transformation and policy rules 

defined in steps 1 & 3. 

5. Render the product images using the Data Values acquired in step 4 and the 

Template Collection defined in step 2. 

6. Update the EPOP devices according to the scheduling rules defined in step 3. 

7. Use Reporter to view the update statistics. 

 

 

The following guide details how to install the Bounce Architect, Processor and Manager 

elements of the Bounce software suite (see Bounce Communicate Installation Guide for how 

to install and use Bounce Communicate element).  

It also details how to create an Architect Policy and Template configuration files and how to 

load these onto a PC running Processor, Communicate and Manager  
 
 
 
 
 
 
 

 
 
 
 

 

 

 

 



 
 

Bounce Architect Installation Guide 
 

Insert the Bounce Architect software CD into your CD-ROM drive. The install setup.exe 

should auto start. If it doesn’t, Click on Start> Run and type D:SETUP.EXE. Replace the D: 

with the appropriate drive letter for your CD-ROM if it is not D. 

 

Once the installer starts you will get the following screen. Click Yes to accept  
 

 
 

Click Accept to install .NET Framework 2.0, you will only receive this message if .NET 

Framework 2.0 has not been previously installed on your machine.  
 

 
 

Click Accept to install Windows Installer 3.1, if not already installed. You will also be 

prompted for a system reboot. After the reboot the installation will continue. 
 

 
 

Click Install, this will install Visual C++ Runtime Libraries and SQLProcessor Instance 
 

 
 

 
 

 
 

 
 



 
 

The following Bounce Architect Setup Wizard will start. Click Next 

 

 
 

It is recommended you use the default location, leave as is and click Next 

 

 
 

Click Next to confirm your installation 
 

 
 

To complete the installation click Close 

 

 
 

This now successfully completes the installation of Bounce Architect. The following section 

demonstrates, how to create a policy and a template collection for use with Communicate 

and Processor. 
 

 

 

 



 
 

Policy Architect 
 

Template fields are created using Policy Architect. Definition of the template fields 

begins by determining all the different data sources that will be used to create them 

and registering these with the Policy Architect application. A data source can take any 

form of data, it may consist of a simple comma separated value file, an Excel 

spreadsheet, an Access database or more complex transactional databases such as 

Oracle or Microsoft SQL Server. 

 

To start the application Policy Architect, double click the icon on your desktop    or 

go to Start > All Programs > ZBD Displays > Bounce Architect > Policy Architect and 

the following Main Screen is displayed as below.  
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The first step in creating a policy is to create a connection to your data source, in the 

example below you will use the sample .csv data file which is provided on the CD – 

D:\Sample Data 

 

Adding a Data Source  
 

Right click DataSources and select Add DataSource 
 

 
 

 

In the following screen below, you will add the name of your Data Source and select 

the connection method to your data.  
 

 
 

In our example we have used a .csv file, select file and click Next. 
 

 
 

The .csv file is available on the CD-ROM – D:\Sample Data You may also have 

downloaded it from the FTP site, the example data can be found in the folder 

Sampledata.zip 

 
 

 

 

 



 
 

To test the data source connection, click the Test and the following connected 

successfully screen below appears, click OK, this validates the file location is valid and 

readable. 

 
 

Click OK again, and now you have successfully added your data source connection. 
 

Once the data sources have been registered you will need to define the data tables 

and the Product data fields that contain the relevant product information to be used in 

creating the product image. 

 

In a situation where there are multiple sources, each of the data tables registered to 

Policy Architect need to be linked to at least one other table to enable Policy Architect 

to determine how to retrieve the correct data values to make a consistent data set. 

Normally each of the data source tables would be linked via the product ID as this is a 

unique identifier that would be consistent across multiple data sets. In our example, 

for illustration purposes, we have used a .csv file, so there is only one table.  

 

Adding a Table 

 

The next step in the process is to link the table within your data source by right 
clicking on the Data source name and select add table, as below 

 

 
 

Now, you will select the Name and Keyfield, as show below, the Keyfield is the unique 

identifier, and the Name is the table name. In our example it’s the file name, because 

you are importing from a .csv file. 

 

 
 

 

 

 

 

 



 
 

You can preview your data source data by clicking Preview, the data will be previewed 

as shown below, then click OK. 
 

 

 

Once you have registered all the data sources and linked the tables you can 

concentrate on determining what fields should be retrieved from the tables in order to 

define the Template Collection fields.  
 

Template Collection fields are a selection of any fields you wish to make available from 

your data source for use in generating your images using Template Architect. 
 

 

 

Adding Template Collection Fields 

 

Next you need to add your template collection field. Right click on the selected field 

name from the imported table you wish to add to Template and Click Add 

 

 

 



 
 

In our example we have chosen to add the following field names. 

EAN Code 

Long Description 

Manufacturer 

Model 

Price 

Product 

ProductID 

PromoPrice 

Short  Description 

It is recommended you use the above field names.  

 

The added field names will also move to the Template Collection Field, as shown 

below. 

 

 
 

Now within the template collection fields you need to set the ProductID field, in our 

example we are using the ProductID. Right click, go to Assign To and select ProductID, 

as shown below. This allows Bounce Communicate to Identify the ProductID 
 

 
 

Click the import button, to preview your selected template collection fields in Policy 

Architect.  

 
 

 



 
 

A special Template Collection field called [Template] must be defined. This field 

contains the name of a Template Architect template that will be used when creating 

the product image. Using Policy Architect we are able to create new template fields by 

applying transformations to the Product data fields e.g. we can create a new template 

collection field called [UnitPrice] that is calculated from the data source by taking the 

[Price] and dividing it by the [UnitWeight]. 

 

In our example we are going to create two [Template] fields which are populated with 

‘Standard’ & ‘Promo’, using transformations. 

 

Transformations 

Transformations allow you to manipulate existing fields or create new constant fields. 

This consist of standard SQL statements and can include any of the Template 

Collection Fields previously added. The SQL statement can be made up of anything 

that is valid in the Select Clause. 

 

Creating a Transformation  

 

To create a transformation right click transformation and select New Transformation, 

the follow screen below appears. 
 

 
 

Enter an appropriate name for the transformation field, in your example you have 

chosen Standard.  

 

 
 

 



 
 

You are going to create a constant, with the value of Standard. As shown below. 
 

 
 

Click the Preview button to see the results of your created transformation. Click Ok to 

finish creating the transformation. 
 

 
 

Now you are going to create a second template field for the promotional data. Repeat 

the above steps, creating a transformation using the transformation name as Promo, 

and creating a constant value of Promo, as shown below.  

 

 
 

 
 

 
 

 

 



 
 

The created transformations will also be added to your template collection field set, as 

shown below 
 

 
 

You also need to assign the transformation template fields created. This is so that 
Policy Architect can determine which template name to use.  

 

Right click on field name Standard in the template collection fields and go to Assign To 

and select Page 1 Template, as below.  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Repeat the above assign task for the second template field name Promo to Page 2 

Template, as shown below. 

 

 
 

You have now successfully created two transformations, one allowing you to create a 

standard image template and the other a promotional template. 

 

Now you are ready to design your Template images using Template Architect. 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 



 
 

Template Architect  
 

Template Architect provides a graphical user interface with a template design view 

alongside a preview view. This allows you to be able to see exactly how a product 

image (or a set of product images) will be rendered from the product data set.  

 

Using the GUI you can select a Template field and define the area on the EPOP display 

that the values contained in the template field should be rendered. A selection of field 

attributes is also available so that you can apply different fonts, font styles, font sizes 

etc. The template field object can be inverted to displays white on black or the object 

can be set to auto fit within a bounding rectangle defined by the user.  

 

Template Architect also allows you to create a collection of templates. This feature 

ensures that different templates can be used when rendering the data to handle 

products that may be on offer, or in a different product category that requires its own 

style. A template collection also includes templates for each of the different EPOP 

types e.g. EPOP 50, EPOP 300 and EPOP 500.  

 

To define your template collection you will need to start Template Architect, this can 

be started within Policy Architect, by clicking the Template Architect icon  , the 

following screen below will appear, click OK to start a new template collection design. 
 

 

 

Save the file with a unique name, for our example we have chosen Sample 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Template Architect main screen and icons 

 

 

 

 

To create a new template, click the new template icon . 

 

Add new Template 
 

You are going to create an image Template for EPOP 500 in landscape layout, with 

template name Standard, this is the name you used previously when creating your 

transformation, click OK. 
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The screen below shows your data imported top left corner, from Policy Architect.  

 

 

 

Now you are ready to start to design your image template.  

 

Select the appropriate fields from the imported data, drag and drop onto the Design 

window, by holding down your mouse and moving the pointer to the design window 

and then releasing the mouse button. The data will be shown on the preview window, 

as shown below.  
 

 
 

It is recommended you add the objects in the design view as above.  

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

To create our second template, for our promotional data, go to the following drop 

down as shown below and select New. 

 

 
 

Enter the details as below, making sure you select Clone Template Standard. This 

allows you to create a clone image of the first template created ‘Standard’. This 

simplifies the task of creating another template if only minimum set of modifications 

are required. 

 

 
 

 

Reposition an object box  

 

Select the text object using left mouse and holding down move the text object to the 

desired position in the Design window or by selecting the object and using the arrow 

cursor keys to move the object.  

 

Resize an Object box 

 

To resize move the mouse cursor to the object border until mouse cursor changes  , 

now you can resize by moving the border line. 
 

 

 

 

 

 

 

 

 



 
 

 

Edit an Object box 

 

Right click on selected object and go to properties 
 

 
  

Advance Object properties, are available on selected object Properties screen.  
 

 
 

Types of Objects 

 

Text Box 

 

Insert a text box 

 

1. In the toolbar, click the text icon 

2. Create a text frame, drag the pointer diagonally to the size you want on the 

design window. 

3. The following text properties box will appear 

 

 
 
 

Static Text 

 

To create static text on your template, enter the text into the text box. 

 

Data Text 

 

To create data text from your data source file, select the field name from the drop 

down list and click Add 



 
 

AutoSize  

 

When autosize is enabled the font size of the text will be adjusted to ensure all of the 

text can be displayed within the bounding rectangle of the text object. By default the 

Autosize function is enabled, note that the defaulted minimum font size is set to a 

value that ensures the text will be rendered legibly on an EPOP. 

 

Turn off Autosize 

 

1. Right click on your selected object and go to properties, uncheck the Auto Size 

check box, by default auto size is the on  

 

 
 

Price Object 

 

Indicates which field determines the price of the product, right click on the Price 

Object and go to properties, the following box will appear. This allows you to change 

the Major and Minor Symbols, it also allows you to change the font size of both 

symbols.  
 

 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

List Object 

 

A List object consists of multiple Text objects and Price objects into one bounded 

rectangle group. This simplifies manipulating them. A list object can be selected, 

moved, resized and edited as one object or individually. List objects can be bounded 

horizontally or vertically. Below the properties box of list objects allows you to set 

various settings, by right clicking the list object and selecting properties.  
 

 
 
 

Once you have completed you template design, you need to save it. From the Menu bar 

select File > Save Collection. 

 

Now you need to go back to Policy Architect and click Import to view the template changes 

you have made.  
 

 
 

Now you have successfully added a data source and selected Template collection fields to 

create a template design standard and promo for you EPOP’s. 

 

To view your data with the template design imported in to Policy Architect. Scroll through 

your records using the up and down arrow in the data preview window. The new image with 

the selected product will be displayed within the Image preview window, this allows you to 

validate the image. 

 
 

 
 

 

 
 

 

 



 
Scheduling  

 

The final step is to define the schedule in which the data source should be read and 

processed.  

 

In our example, we are going to create a schedule that will run our standard template 

image with a our promotional Image displayed between the hours of 4pm and 6pm of 

each day.   

 

To set the schedule, click the schedule icon in Policy Architect , and the following 

screen below will appear. 
 

 
 

A new policy configuration is created with a default schedule. In our example we want 

to use a more complex schedule. Delete the default schedule by selecting it and 

clicking on the “Remove” button  

 

Click Add, to open the schedule creation window, as shown below.  

 

 
 

Schedule 1 Setting  

 

 
 

 



 
Schedule > Select All 

  This determines we wish the schedule to run daily, on all the selected days. 

 

Action> DownloadAndUpdate 

This downloads and updates the EPOP with new image, and also monitors for 

any change to the data source and will update the EPOP with the new image 

 

Page > 1 

This will only update page 1 with the new image, any changes to the page 2 

image will also be downloaded to the EPOP, but not displayed. 

 

Schedule Type > Recurring > Period 

   Start 00:00 

   Finish15:59 

  This is the time the schedule will run between 

 

Interval > 00:00:30 

  This will run every 30 seconds to check datasource for any changes  

 

Schedule 2 Setting 

 

 
 

Schedule > Select All 

  This determines we wish the schedule to run daily, on all the selected days. 

 

Action> Update 

  This will update the EPOP with new image 

 

Page > 2 

This will update only page 2 with the new image, (if you can remember we 

set our template field in policy architect Promo > Page 2 template) 

 

Schedule Type > One Off> 16:00 

  This will run at 16:00 

 

 

 

 

 

 

 

 

 

 

 

 



 
Schedule 3 Setting  

 

 
 

Schedule > Select All 

  This determines we wish the schedule to run daily, on all the selected days. 

 

Action> DownloadAndUpdate 

This downloads and updates the EPOP with new image, and also monitors for 

any change to the data source and will update the EPOP with the new image 

 

Page > 2 

This will only update page 2 with the new image, any changes to the page 1 

image will also be downloaded to the EPOP, but not displayed. 

 
Schedule Type > Recurring > Period 

   Start 16:01 

   Finish17:59 

  This is the time the schedule will run between 

 

Interval > 00:00:30 

  This will run every 30 seconds to check datasource for any changes  
 

Schedule 4 Setting  
 

 
 

Schedule > Select All 

  This determines we wish the schedule to run daily, on all the selected days. 

 

Action> Update 
  This will update the EPOP with new image 

 

Page > 1 

This will update only page 1 with the new image, (if you can remember we 

set our template field in policy architect Promo > Page 2 template 

 



 
Schedule Type > One Off> 18:00 

  This will run at 18:00 
 

Schedule 5 Setting  

 

 
 

Schedule > Select All 

  This determines we wish the schedule to run daily, on all the selected days. 

 

Action> DownloadAndUpdate 

This downloads and updates the EPOP with new image, and also monitors for 

any change to the data source and will update the EPOP with the new image 

 

Page > 1 

  This will only update page 1 with the new image 

 

Schedule Type > Recurring > Period 

   Start 18:01 

   Finish 23:59 

  This is the time the schedule will run between 

 

Interval > 00:00:30 

  This will run every 30 seconds to check datasource for any changes 

 

It is recommended to use the above settings. 
 

Your completed schedule should look as shown below. 

 

 
 

Now click OK to save the schedule. 

 

 

 



 
 

Congratulations, you have completed the configuration phase of the Bounce Software.  
 

To use the configuration files with Bounce Processor and Bounce Communicate, you will 

need to export and save your Policy and Template Architect configuration files, which will be 

uploaded via Bounce Manager 

To export your configuration file, click on the export icon  in Policy Architect and save 

file.  

 

The Template Architect configuration file you have already saved, when creating the New 

template collection, but you will need to re-save any changes made, by selecting File > 

Save Collection in Template Architect, as show below.  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

The following sections detail how to install Bounce Processor and Bounce Manager on a PC 

running the Bounce Communicate software (see Bounce Communicate Installation Guide). 

 

In each location that has EPOPs deployed a PC must be set up to manage the network of 

EPOPs and perform the communication functions. This PC will also be required to run 

Bounce Processor to monitor the data fields specified in Policy Architect and render the 

images specified in Template Architect. Bounce Manager is also required to Manage the PC 

Configuration 

 

The following section assumes that the user has already installed and set up Bounce 

Communicate on a PC as documented in the Bounce Communicate installation guide. 

 

Bounce Processor Installation Guide 

 

To start the installation of Bounce Processor, run BounceProcessorSetup, click Yes on 

the following screen below to continue installation process. 

 

 
 

The following setup wizard will start, click Next 

 

 
 

It is recommended you use the default location, leave as is and click Next 

 

 
 

Click Next to confirm your installation 

 

 
 

 

 

 



 
 

To complete the installation of Bounce Processor click Close  

 

 
 

Your installation of Bounce Processor is now completed. A new windows service has 

now been installed. Before Bounce Processor will process any of your data sources you 

will need to upload your Policy configuration and Template collection files. To do this, 

you will need to install Bounce Manager. 
 

Bounce Manager Installation Guide 

 

To start the installation of Bounce Manager, run BounceManagerSetup. The following 

Bounce Manager Setup wizard will start, Click Next to continue the installation. 

 

 
 

It is recommended you use the default web site, leave as is and click Next. 

 

 
 

Click Next to confirm your installation  

 

 
 

 
 

 

 



 
 

To complete the installation click Close 

 

 
 

Your installation of Bounce Manager is complete. The Bounce Manager web pages 

have now been installed and can be accessed via the following URL http://localhost 

 

To load the Policy and Template Architect configuration files, you will need to run 

Bounce Manager, and select configuration update, as shown below  

 

 
 

Click the browse button under Policy Config and locate your saved Policy Architect 

configuration file with extension .zpa, you need to do the same for the Template 

Architect collection file with extension .zta. Finally click the Load Configuration button. 

You will receive the following status message as shown below.  

   

 
 

Congratulations you have successfully loaded your Policy and Template Architect files 

which will be used with Bounce Processor and Bounce Communicate. 

 

Bounce Processor will now perform the function of acquiring the data against the 

schedule of operations as defined in Policy Architect, then performs any required 

transformations and uses the acquired and transformed data to render a product 

image. For each product in the acquired data set a unique image will be generated 

using the specified template style designed in Template Architect. 

 

 

 

 

 
 

 

 



 
 

Custom Images 

 

 
 

Custom images are a set of system images, which are updated to the EPOP when 

specific operations are performed.  

 

The following system images  

 

Configured  - Image used to when the EPOP is initially added to the system 

  
  No Image Available – Image used when the EPOP has no other image 

 

  Unassigned – Image used when the EPOP is unassigned  

 

Bounce Manager allows you to change the system images, this is useful if you require 

to add you own personalised images.  

 

 

Assignment Manager  

 

 
 

Assignment Manager, allows you to add/assign and delete your EPOPs to products  

 

To add/assign EPOPs enter your EPOP serial number and click the Enter button, then 

follow by entering you Product ID and click Enter.  

 

To delete EPOP from the system, enter your EPOP number and click Enter and type 

‘DELETE’ (must be entered in uppercase) and click Enter, this will now delete the EPOP 
from you system 

 

 

 



 
 

Alerts 

 

 
 

The Alerts page shows you useful system information, such as database size, 

communicator attached, and any system errors. Alerts are classified as informational, 

warning and critical.  

 

Report manager  

 

 
 

Report manager gives you a system summary overview and also has a set for 

generated reports detailing when Products and EPOPs have been updated, it also 

includes failed transmission reports. 

 

Failure Report 

 
 

The shows you the EPOPs which failed last product update 

 

 

 

 
 

 

 

 

 

 

 



 
 

Product Information 

 

 
 

A report generated giving you details of products currently on your system 

 

Product History 

 
 

A detailed history report of products activity on your system 

 

 

EPOP History  

 

 
 

A detailed history report of EPOP activity on your system 

 

 

  

 

 

 

 

 

 

 



 
Weekly Updates 

 

 
 

A weekly report generated for number of updates, sorted by product. 

 

Processor Audit 

 

 
 

Processor report which shows you the activity preformed by Bounce Processor of the 

schedule created in Policy Architect  

 

Update Queue 

 

 
 

Shows what is currently queued in Bounce Communicate  

 

 

 

 

 

 

 

 

 


